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 Requisition routing allows remote users to 
enter a requisition and have it flow through an 
approval process that ultimately ends in the 
requisition becoming a Purchase Order.  This 
speeds up the requisition approval process and 
allows for automated management of requisition 
approvals and a paperless environment. 
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What we will learn today 

• How to enter a requisition. 
 
 

• How to review the status of a requisition. 
 
 

• How to manage your queue and approve a 
requisition. 
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How to enter a requisition 

• How to open the requisition module. 
• How to add a new requisition. 
• What fields are in the requisition entry form. 
• How to add items to a requisition. 
• What fields are in the requisition items form. 
• How to save and create the requisition. 
• How to save a requisition in draft mode. 
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How to open the requisition module 

• From the main QSS screen, go to the 
AP/Purchasing folder and click on 
Purchase Orders / Requisitions. 
 

• You can also add the Purchase Orders 
/ Requisition module to your 
favorites and open it from there. 
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How to add a new requisition 
• You must be on the requisition tab in 

order to create a new requisition. 
 

• You can create a new requisition by 
clicking on the “green plus” icon, 
using the keyboard shortcut “F9”, or 
going to Options > Add. 
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What fields are on the requisition 
entry form 

• Requisition number 
• Purchase Order number 
• Control number 
• Warehouse 
• Stores Order 
• Vendor/Address number 
• Date 
• PO Type 
• Delivery By 
• Confirming message 
• Description 
• Tax % 
• Ship To address 
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What fields are on the requisition 
entry form 

• Submitted by 
• Terms 
• Commodity code 
• Site number 
• FOB 
• Buyer 
• Program 
• Misc Date 
• Misc 
• Routing Group 
• Room 
• Discount % (Version L Only) 
• Shipping % 
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What fields are on the requisition 
entry form 

• Accounts 
• Address (00 – Default) 
• Additional (addresses) 
• Shipping (address) 
• Beginning Message 
• Ending Message 

9 



Definition of the fields on the 
requisition entry form 

• Requisition number – This field can be setup to be automatic via an odometer or 
manually entered. 

• Purchase Order number – This field can be setup to be automatic via an odometer or 
manually entered. 

• Control number – This field is ONLY supported in Version L.  This is an internal number 
that your organization can use to assign a number to this requisition/purchase order.   

• Warehouse – Leave blank in most cases.  If the interface is active, can create a 
Warehouse stores order. 

• Stores Order  number – Can either be manually entered or the odometer can be used. 
• Vendor/Address number – This is the vendor that will be used to purchase the items on 

this requisition.  You may also select a specific remit address here. 
• Date – This field will default to today’s date as long as the user is logged into the current 

fiscal year, otherwise if you are in the previous fiscal year, it will default to the last day 
of that fiscal year.  This field is editable as well. 

• PO Type – Typical PO types are Purchase Order, Blanket PO, Confirming Purchase Order, 
and Service Agreement. 
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Definition of the fields on the 
requisition entry form 

• Delivery By – This is an optional field that you can type a date in. 
• Confirming message – This is a message that can be set to print on the PO after 

requisition becomes a PO.  These messages are created by your system 
administrator. 

• Description – This is a 30 character field. 
• Tax % - This will display the default tax %, you can type a different %. 
• Ship To address – This field allows you to select the address to ship the items to. 
• Submitted by – Optional field to type the name of the submitter of the requisition. 
• Terms – Optional 20 character field, used for specifying FOB or discount.  With 

appropriate security, can have default Terms/FOB. 
• Commodity – Optional field, can select a commodity code from the list if setup. 
• Site – Select a site from the list, usually the site that is ordering the items. 
• FOB – Optional field, can type the FOB point, this information will print on the PO. 
• Buyer – Depending on security can be optional or mandatory.  Can select a buyer 

code from the drop down list. 
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Definition of the fields on the 
requisition entry form 

• Program – Optional field, can type a program name associated with the PO. 
• Misc. Date – Optional field, can type a date for tracking PO’s.  This field can be 

relabeled via user security. 
• Misc. – Optional field, this is a 4 character field. This field can be relabeled via user 

security. 
• Routing Group – This field only shows for sites that are using requisition routing.  If 

you only belong to one routing group, only that group will show and you cannot 
change it.  If you belong to two or more routing groups, you can change the group 
to the one you wish to use.  Every user should have a primary group that would be 
the default group, this is what would automatically be entered when a new 
requisition is created. 

• Room – Optional field, this is a 20 character field. 
• Discount % - Version L ONLY - This sets a global discount for the entire requisition, 

this can be overridden on an individual item as well as in the items form. 
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Definition of the fields on the 
requisition entry form 

• Shipping % - This is an informational field showing the shipping percentage 
charged by the vendor from the vendor master file. 

• Accounts field – This is where you enter the account code/s that will be used for 
this requisition.  Up to 40 accounts can be added here.  You may also enter a 
pseudo-code if set up correctly (speeds up entry of commonly used accounts). This 
also allows you to charge a specific percentage to each account.  The grid also 
includes the budget balance for each account. 

• Address Tab – Default main address will show up here. 
• Additional Tab – Additional addresses show up here. 
• Shipping Tab – The Ship To address will show up here. 
• Beg Message – Beginning message that will print on the PO form. 
• End Message – Ending message that will print on the PO form. 
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How to add an item to a requisition  

• You can add an item one of three 
ways. 

– Click on the Items Icon. 
– Under the Options menu, select Items. 
– Use the keyboard shortcut “F4”. 

 

• Additional Information 
– Required fields on the main requisition 

form must be entered before it will allow 
you to go to the Items form. 

– Errors on the main requisition form must 
be cleared before it will allow you to go to 
the Items form. 
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What fields are on the requisition 
entry Items form 

• Subject to Tax 
• Rate % 
• Sub Total 
• Total Tax 
• Total 
• Item line # 
• Print 
• Split 
• Quantity 
• Unit 
• Unit Cost 
• Total Cost 
• Tax 
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What fields are on the requisition 
entry Items form 

• Stock # 
• Fixed Asset 
• Description 
• Accounts 
• Item Summary 
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Definition of the fields on the 
requisition entry Items form 

• Subject to Tax – Informational only, total of all line items subject to tax. 
• Rate % - Informational only, Tax Rate used for the requisition. 
• Sub Total – Informational only, Sub total of all line items before tax. 
• Total Tax – Informational only, total tax amount for all line items subject to tax. 
• Total – Informational only, total amount for all line items after tax. 
• Item line # - The current Item line number you are on. 
• Print – You have four options.  

– Yes – Will print line item information and description on the PO form. 
– No – You cannot enter line item information except for a description.  The information you enter in 

the description only shows up online and will not print on the PO form.  To avoid a blank line on the 
printed PO form, use this option as your very last line item. 

– Display only – You cannot enter line item information except for a description.  The information you 
enter in the description will be combined with the previous line item description.  This is used to 
created extended or very large descriptions.  Each description allows 60 lines, you may have up to 
990 lines of description by using this method to extend the description. 

– Ship/Freight – Use if this item is to record the shipping/handling for the requisition.  Use split code as 
necessary to change shipping/handling to appropriate account(s).  Enter shipping/handling amount 
in unit cost and mark taxable if applicable. 
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Definition of the fields on the 
requisition entry Items form 

• Split – You have four or more options.  CP(calculate percentage is the default). 
– Calculate percentage – The system calculates how much to charge to each account.  It multiplies the 

total for the account line by the percentages for each account on the Requisition Entry form. 
– Special Percentage – Specify the percentage of the line item to charge to each account.  Fill in the 

Item Percent column for each account in the Accounts Grid, the total percentage must be 100%. 
– Special Dollar – Specify the dollar amount to charge to each account.  Fill in the Item Amount column 

for each account in the Accounts Grid, the total amount must be equal to the Total Cost for the item. 
– Account Line xx – This allows you to charge the entire line item to a specified account line. 

• Quantity – This is a whole number for how many items to order.  In version L, this 
can be a fractional quantity. 

• Unit – This is a unit of issue up to four characters long. 
• Unit Cost – This is the cost of each unit.  You may go up to four digits to the right of 

the decimal point for items that have fraction of a cent prices. 
• Total Cost – The system calculates the total cost for the line item. 
• Tax – Select “Yes” for an item subject to tax or “No” for a non-taxable item. 
• Stock # - Leave blank, or type a stock number from the Stores system. 
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Definition of the fields on the 
requisition entry Items form 

• Fixed Asset – Select “Yes” to flag this item as a fixed asset, otherwise leave blank or 
“No” if the line item is not used to associate the item with a fixed asset on file in 
the Fixed Assets system. 

• Description – Each line item can have up to 60 lines of description up to 36 
characters long.  The maximum number of lines for a requisition is 990.  The first 
item on a requisition must have at least one line of description. 

• Accounts – The Accounts grid displays the accounts for the requisition, as defined 
on the Requisition Entry form.  The Amount is the total charged to each account 
for the entire requisition.  The totals will only update after the item has been 
saved. 

• Item Summary – The Items grid displays the cost of each line item.  It is updated 
each time you save a line item. 
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How to save and create the requisition 

• Once you have entered an item, you 
have three ways to save the item. 

– The Save Item icon. 
– Under the Options menu, select Save Item. 
– Use the keyboard shortcut “F9”. 

• You can enter additional items one of 
three ways. 

– The Add Item icon. 
– Under the options menu, Add Item. 
– Use the keyboard shortcut “F8”. 

• You may also use the Save Item/Add 
Item feature.  This has three ways as 
well. 

– The Save Item/Add Item icon 
– Under the Options menu, Save Item/Add 

Item. 
– Use the keyboard shortcut “Shift F8”. 
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How to save and create the requisition 

• When you are done adding items you 
have two options. 

– Save Item/Main, this will save the item you 
are on and take you back to the main 
requisition entry screen. 

– Save Item/Main/Save, this will save the 
item you are on and save the entire 
requisition giving you a requisition 
number. 

• You have three ways to toggle back to 
the main requisition entry form. 

– The Main icon. 
– Under the File menu, select Main. 
– Use the keyboard shortcut “F12”. 
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How to save and create the requisition 

• After you have completed adding 
items you can either save the entire 
requisition from the item screen or if 
you return back to the Main 
requisition entry form you have three 
ways to save/create the requisition. 

– The Save icon. 
– Under the options menu, select Save. 
– Use the keyboard shortcut “F9”. 
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How to save and create the requisition 

• After clicking Save, you should 
receive a dialog box with the 
requisition number. 
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How to review the status of a 
requisition 

• How to search for a requisition. 
• How to bring up the requisition status form. 
• What information is in the requisition status 

form. 
• What does this information mean. 
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How to search for a requisition 

• Enter a requisition number in the first 
field which will search only for that 
requisition. 

• Enter a requisition number in both 
fields to search and return a range of 
requisitions. 

• After you have entered the 
requisition number you can search in 
three ways. 

– Binoculars Icon. 
– Option menu, then click search. 
– Keyboard shortcut “F3”. 

• You may also search with the PO 
number in the same fashion, just use 
Purchase Order number fields. 
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How to search for a requisition 

• Advance Search  
– This gives you the ability to use many 

filters to refine your search. 
– For a full description of all the fields you 

can search on, take a look at 
(QCC_Accounts_Payable_Purchasing 
Manual) starting on page 4-97. 
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How to bring up the requisition status form 

• There are two ways to bring up the 
requisition status form. 

• The first way is from the search grid, 
simply right click on the requisition 
line you wish to view.  This will bring 
up a sub-menu, select “Remote 
Status”. 
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How to bring up the requisition status form 

• The second is to open the actual 
requisition. 

• Here you have two ways to open the 
requisition status form. 

– Options Icon on the toolbar, select 
“Requisition Status”. 

– Options menu, select “Requisition 
Options”, then select “Requisition Status”. 
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What information is on the requisition 
status form 

• Series number 
• Sequence number 
• Suffix number 
• Queue ID 
• Rule name 
• User 
• Date field 
• Time field 
• Status 
• Show History(check box) 
• Show Approvers(check box) 
• Show Change Log(check box) 
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What does this information mean 

• Series number – This number will always start out at zero and whenever there is a 
change made to the requisition, it will increase by one. 

• Sequence number – This number will increase for every approval stop.  If there is a 
change made to the requisition that causes the Series number to change, then the 
Sequence number will reset back to one and again increase by one for each 
approval stop. 

• Suffix number – This number will usually be zero, it only changes when a Node or 
Route has been inserted into a requisition via the re-route option, this lets us know 
that the route has been modified manually. 

• Queue ID – This is the name of the queue for this approval stop. 
• Rule name – This is the name of the Rule that was evaluated for this Queue.  

$AUTO is a special rule that will ALWAYS be included in the creation of the route. 
• User – This is the name of the User who has approved this approval stop. 
• Date field – Only set when node is approved, changed, referred, or re-routed. 
• Time field – Only set when node is approved, changed, referred, or re-routed. 
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What does this information mean 

• Status – This field tells you what the status is for each approval stop.  If the requisition 
has not yet arrived to an approval stop, it will be blank. 

– A = Approved. 
– C = Change was made. 
– P = PO was assigned. 
– R = Referred back to a previous approval stop. 
– W = Waiting for approval 
– X = A Node will be marked with an X when a Change, Refer, Re-route is performed and the Series changes.  

All the approval stops after the Change, Refer, Re-route should be marked with an X.  X Status will only show 
up when you have the “Show History” box checked on the requisition status form. 

– XO = A re-route was performed.  A Node or Route was inserted before or after the current approval stop.   
This includes replacing a Node or Route as well. 

• Show History – By checking this option, you will see the entire detailed history of the 
requisitions route.  This includes all the approval stops that were marked with an X 
because of a change made. 

• Show Approvers – By checking this option, you will see who can approve each Node in 
the route. 

• Show Change Log – Will show the changes made and give details of who made the 
change, when it was changed, and what was changed. 
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How to manage your queue 

• What fields are being displayed in the grid. 
 

• Definition of the fields in the grid. 
 

• What options are available when on the 
queue tab. 
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Understanding the grid and what 
information is being displayed. 

• Check box 
• Se 
• Req number 
• Vendor  
• Amount 
• Date added 
• Del By 
• Subt By 
• Site 
• Commodity code 
• PO(status) 
• App Notes 
• RQ Notes 
• NT 
• Queue number 
• Queue name 
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Definition of the fields in the grid. 
• Check box – Checking this will select the requisition for a queue management 

action. 
• Se – The series number of the requisition.  The original series number is always 00.  

A new series begins when a change is made to the requisition. 
• Req number – The requisition number. 
• Vendor – Name of the vendor. 
• Amount – Total dollar amount of the requisition. 
• Date added – The computer’s date stamp for when the requisition was created. 
• Del By – The deliver-by date from the main requisition form. 
• Subt By – The server logon ID of the submitter. 
• Site – The site for the requisition. 
• Commodity code – The commodity type code for the PO. 
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Definition of the fields in the grid. 
• PO(Status) – This lets us know if the approval stop can be turned into a PO. 

– N or Blank – It can’t be turned into a PO at this approval stop. 
– P – It can be turned into a PO at this approval stop.   P should show up on the last node as well. 

• App note – Approval notes, it will say “Yes” or “No”.  This field is a link and will take 
you directly to the approval notes. 

• RQ note – Requisition notes, it will say “Yes” or “No”.  This field is a link and will 
take you directly to the requisition notes. 

• NT – A “Y” means there is a note for this requisition, otherwise it will be blank. 
• Queue number – The queue number for the requisition.  Depending on how your 

organization has set up the Queue tab, you might have a Queue Legend.  If you do, 
this number will correlate with a number in the Queue Legend that will then give 
you the queue name, owner of the queue, and whether or not the owner is 
absent.  We have recently added the queue name into the grid so that this feature 
can be turned off to allow for more room in the grid. 

• Queue name – Name of the Queue. 
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What options are available when on 
the queue tab 

• Approve 
• Approve with a note 
• Refer 
• Re-route 
• Inspect 
• View 
• Assign PO 
• Show 
• Cancel 
• Set Absence 
• Grid output 
• Print screen 
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Definition of the options available 
when on the queue tab 

• Approve – This will approve the requisition/s that you have selected.  Once this is 
done, the requisition will move to the next approval queue. 

• Approve with note – Same as approve, except it will open the approval note form 
for you to add an approval note. 

• Refer – If this option is available to you, it will allow you to refer a requisition back 
to a previous queue. 

• Re-route – If this option is available to you, it will allow you to insert or replace a 
Node and/or entire route.  This is a very powerful option that can bypass the 
normal routing rules.  Use this with care. 

• Inspect – This will open up the requisition you have selected.  If more than one 
requisition is selected, it will only open the first one. 

• View – This opens the PO/REQ quick view form. 
• Assign PO – This features bypasses the standard requisition routing rules and 

allows you to assign a PO immediately.  This feature is available only with proper 
security. 
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Definition of the options available 
when on the queue tab 

• Show – This opens the requisition status form. 
• Cancel – This will cancel the requisition with appropriate security. 
• Set Absence – This allows you to mark yourself as absent for a specific date range.  

If setup properly, this will allow your backup approver to automatically have access 
to your requisitions to be able to approve. 

• Grid output – This will allow you to save everything in the grid to PDF, Word, or 
Excel. 

• Print screen – Standard QSS Print screen function. 
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Additional Options on the Queue 
Management tab 

• Settings 
• Clear Settings on Exit 
• View Attachment 
• Show Approved PO’s 
• Select Processing Queue 
• View Users Queue 
• Select User Profile 
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Additional Options on the Queue 
Management tab 

• Settings – You have four options in settings. 
– Account Settings – This allows you to save favorite account code and pseudo codes. 
– Default startup screen – This allows you to choose Queue Management, Requisition, or Purchase 

Order  tab that will be active when you first log on. 
– PO Quick View Settings – This allows you to choose what you want to see when you open a PO Quick 

View. 
– View Queue Legend – This allows you to turn on or off the Queue Legend. 

• Clear Settings on Exit – This will return all your custom settings to the default. 
• View Attachments – This will open the attachment form and if the selected 

requisition has an attachment, you can then view it. 
• Show Approved PO’s – This will show the most recent approved PO’s. 
• Select Processing Queue – This option is for Super Users Only.  This will allow you 

to select any other users queue and perform the approval operations. 
• View Users Queue – This option is for Super Users Only.  This will allow you to 

select any other users queue and view what is in their queue. 
• Select User Profile – This allows a user to have up to three GUIPURCH profiles. 
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